i

I/,
//}

f

y
P

L)

Markets Division

Information for institutional and corporate investors’ reference only

November 2022

s

o’
9
4
7
7
4

ANSSRRRR

HKEX

X & Fh



Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in November 2022

Sector Indices vs HSI / HSCEI

CES120 vs China Theme Indices

Index Name Index Name
HSI - +17.8% FTSE A50 Index _ +9.0%
HS Mainland MSCI China A
! - +14.0% 50 Connect _ +7.6%
Banks Index Index
HS Mainland 0 CSI 300 Index +7.6%
Oil & Gas Index +9.5% o
. % Change
Equity Index Futures Access Codes
HS Mainland HS Mainland
Vendor HS Mainland Banks Properties Oil & Gas CES 120 HSI HSCEI
Bloomberg BMWA PPTA OGIA CESA HIA HCA
Refinitiv 0#HMBI: O#HMPI: 0#HMOI: O#HCHH: 0#HSI: O#HCEL:
WIND MBIF MPIF MOIF CHHF HSIF HHIF
ET Net MBI MPI MOI CHH HSI HHI

Data Source: Bloomberg

As at 30 November 2022
Information for reference only
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Equity Index Futures & Options
Hang Seng Index (HSI) Futures & Options

rS! Products HS! Options (YoY)
(2022 vs 2021)

Av erage Daily Volume Open Interest Av erage Daily Volume Open Interest
(No. of Contracts) (No. of Contracts) (No. of Contracts) (No. of Contracts)
) o 280,000 - mmmmm ADV (L-Axis) - 200,000 60,000 - ADV (L-Axis) - 400,000
HSI Futures 153,100 (+10%) 136,061 (+14%) 240,000 - Open Interest (R-Axis) Open Intergst (R-Axis)
200,000 - - 150,000 45,000 - - 300,000
160,000 - O
o - 100,000 30,000 - - 200,000
Mini-HSI Futures 107,836 (+8%) 14,281 (-13%) 120,000 -
80,000 ~ - 50,000 15,000 - - 100,000
40,000 -
0 - -0 0~~~ +++++++——+0
HSI Options 25,957 (-2%) 127,016 (+55%) D > o O NI N G
) 1 (1, rl,
PR R P P N S SN S S SN
HSI Futures (MoM) HSI Options (MoM)
Mini-HSI Options 12,339 (+10%) 20,159 (+75%)
Av erage Daily Volume Open Interest Average Daily Volume Open Interest
(No. of Contracts) No. of Contracts
(Nz%g 88'6'5‘?15)— ADV (L-Axis) (N?' 0588"%3615) 45,000 - ADV (L-Axis) ( 2 0158:6%0)
' pen Interest (R-Axis) ' Open Interest (R-Axj
HSI Futures 104,339 |
. 2,359 (+1674% ! 150,000 - n - 150,000
Options ( ) (+1856%) g it 30,000 - - 100,000
100,000 - - 100,000
. 15,000 - - 50,000
HSl V0|atI|Ity 0 (_) 0 (_) 50,000 ] L 50'000
Index Futures
01 0 0 o) > o > 0
o C — - cOs == oo
HSI Dividend 858328538888 388828533588
Point Index 31 (+3%) 3,171 (509%) Jha I ohoh 5092
Futures

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 30 November 2022
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Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level HSI & Top 5 Constituents

. Includes the largest and most ('000)
Index Description

liquid stocks listed in Hong Kong 22 1 ——HS| ——VHSI 46 1200 ___jigiindex  —— Tencent

Index Level 18,597.23 (As at 30 Nov 2022) L 42 ;S.?C glAb
eituan aba
20 -
Index Volatility (30-Day Historical) | 29.3 L 38 100
Index Avg. Day High-Low Range 437.58 (Nov 2022) 18 - L 34 | ;
HSCEl Correlation (2022) 0.989 - 30 80 - Y A\ 4
16 - e
- 26 '

14 T . 22 60
Sep-22 Oct-22 Nov-22 Sep-22 Oct-22 Nov-22

Hang Seng Index Futures

Contract Multiplier HK$50

Notional Value (1 Contract) HK$0.93Mn (As at 30 Nov 2022) Distribution of HSI Index Options Ol in Month-end

Call Put
Transaction Cost* 358
36.8 ~33.
5 332 =3 %88
Stamp Duty N/A S 388 £26.0
< 26.0 o 24.0
_ o 24.0 2220
Trading Fee HK$10 / contract L 220 & 20.0
& 20.0 o 19.0
o 190 < 18.0
SFC Levy HK$0.54 / contract = 1848 7 17:0
n 16.0 x %28
. . x 15.0 ) 140
Commission Rate Negotiable Q 14.0 213
2 SHRE
Margin as of 21 Nov 2022 HK$85,300 110 110
10.0 10.0
9.0 | r . r , 9.0 —_—
0 1 2 3 4 012 3 456 7 89
Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 November 2022
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Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Products

(2022 vs 2021)

HSCEI Futures

Mini HSCEI
Futures

HSCEI Options

HSCEI Futures (YoY)
ADV ol* _
Av erage Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)

180,838 (+42%)

13,602 (0%)

45,365 (+0%)

HSCEI Options (YoY)

Av erage Daily Volume
(No. of Contracts)

Open Interest
(No. of Contracts)

200,000 - mmmmm ADV (L-Axis) - 700,000 120,000 - ADV (L-Axis) - 2,800,000
Open Interest (R-Axis) Open Interest (R-AXis)
- 600,000 ] - 2,400,000
653,914 (+84%) 160,000 1 500,000 100,000 2,000,000
I ' 80,000 - e
120,000 - - 400,000 - 1,600,000
60,000 -

80,000 - - 300,000 . - 1,200,000

4,956 (-29%) - 200,000 0,000 1 - 800,000

40,000 1 - 100,000 20,000 - - 400,000

0 - 0 (pi«SEEEEEEEEENME NN

VS S S S
1,581,502 (+60%) L L S LA

HSCEI Options (MoM)

HSCEI Futures (MoM)

Av erage Daily Volume

Open Interest

Av erage Daily Volume

Open Interest

Mini HSCE 3,446 (+105%) 41,995 (+417%) (N of Conracts) (No.of Contracts)  (No.of Contracts) (No. of Contracts)
Options 275,000 | s ADV (L-Axis) - 700,000 80,000 - ADV (L-Axis) ~ 2,000,000
Open Interest (R-Axis) | Open Interest (R-AXis)
220,000 - 600,000
HSCEI Futures - 500,000 60,000 - - 1,500,000
. 18,079 (+1228%) 960,988 (+1032%) 165,000 - 400,000
S ' 40,000 - - 1,000,000
110,000 - - 300,000 ' ,000,
. - 200,000
HSCEI Dividend 55,000 - 20,000 - - 500,000
Point Index 1,405 (+20%) 100,184 (+89%) - 100,000
Futures . ) 0 0
Ol c S >csoan 2
858828532588
2 2021 2022

Data Source: HKEX

* Ol compared to previous year-end
Information for reference onlv

As at 30 November 2022
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI HSCEI & Top 5 Constituents

. Comprises the largest and
Index Description ¢ lauid Hsh 125 -
most liquid H shares .
g ———HS| ==—HSCEI 1209 _HScEl ——Ping An
Index Level 6,374.44 (As at 30 Nov 2022) 120 Tencent = CCB
Meituan Baba
Index Volatility (30-Day Historical) | 34.2 115 - 100
Index Avg. Day High-Low Range 171.45 (Nov 2022) 110 A
Correlation with HSI, CES120 (2022)| 0.989,0.95 105 - 80 -
Correlation with CSI300, FTSE A50 0.784.0.807 100 -
(2022)
95 " r . . 60
1-Nov 8-Nov 15-Nov 22-Nov 29-Nov Sep-22 Oct-22 Nov-22

Contract Multiplier HK$50 Distribution of HSCEI Index Options Ol in Month-end
Notional Value (1 Contract) HK$0.32Mn (As at 30 Nov 2022) Call Put
15.4
15.4
136 5136
5 12.0 gt2.0
Transaction Cost* § 10.4 ?0'4
o 94 T 9.4
Stamp Duty N/A § 8.4 084
o 7.4 574
. < 7]
Trading Fee HK$3.5 / contract 05) 6.4 =< 6.4
()
x 5.4 '8 54
SFC Levy HK$0.54 / contract § 4.7 =47
T 42 4.2
Commission Rate Negotiable 20 bbioo— 20 f i i X
_ 0 10 20 30 40 50 60 70 0 20 40 60
Margin as of 21 Nov 2022 HK$31,900 Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 November 2022
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Weekly HSI & HSCEI Options Performance

Contract Multiplier HK$50

Volume
. . Akuna, Eclipse, I-Access, IMC, Maven, ~ (No. of Contracts)
Liquidity Providers ) .
Optiver 35 000 - ® Weekly HSI Options
30,000 lWeekIy HSCEI Options
Transaction Cost* 25,000
Stamp Duty N/A 20,000
_ 15,000
Trading Fee HK$10 / contract 10,000
SFC Levy HK$0.54 / contract 5,000
- . 0
Commission Rate Negotiable dd daddadadadadadadadadadadadadaaaag
o A A A A A A A A
TN AIRNTIFICAINORNRDINDIT D DB O
A A N NNNNNNM
i Volume
Weekly HSCEI Options e contracts) |
Contract Multiplier HK$50 24,000 - ==\ eekly HS| & HSCEI Options Call
L . Akuna, Eclipse, I-Access, IMC, Maven, 20.000 - Weekly HSI & HSCEI Options Put
Liquidity Providers Obtiver '
E 16,000 -
12,000 -
1 *
Transaction Cost 8,000 -
Stamp Duty N/A 4,000 -
Trading Fee HK$3.5 / contract 0 —_—
SogooogdgSodggogggsoggs
SFClLewy HKS0.54 / contract SO ¥IN®509INENIIINIDD I
A N NN NNNNM
Commission Rate Negotiable

An investment tool to manage short term event risk

Data Source: HKEX
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 November 2022
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Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2022 vs 2021) _— No. of Single Stock Derivatives

Stock Futures 7,875 (-18%) 34,621 (+18%) Single Stock Futures
Stock Options 586,501 (-8%) 9,738,365 (+22%) Single Stock Options 124
Stock Futures (YoY) Stock Options (YoY) Latest and Future Developments
Av erage Daily Volume Open Interest ~ Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
121000 1 _'SDV (:—'f\XiS)t R A r 401000 800,000 - ADV (L-Axis) ' ~ 12,000,000 Stock Futures
10,000 - pen Interest (R-Axis) , 23,888 600,000 Open Interest (R-Axis) | 10,000,000
8,000 - | s ’ - 8,000,000 » Products
25,000
6.000 - . 20000 400,000 - - 6,000,000 > 3 A-shares ETFs futures contracts
4.000 4 L 15.000 4,000,000 » Total 98 stock futures contracts
' - 10,000 200,000 -
2,000 - . - 2,000,000
' I I | - 5,000
o mAl [ Lo o A AEIIRIRNNINE

Q 3 ) Q) Q
(19\ {19(1' (19\ q,d\ (19\ fl,Qq' q/Q({),

Stock Futures (MoM) Stock Options (MoM) Stock Options

Av erage Daily Volume Open Interest Average Daily Volume Open Interest Products ;
(No. of Contracts) (No. of Contracts) ~ (No. of Contracts) , (No. of Contracts) > 3 A-shares ETFs options contracts
_ — ADV (L-Axis) a 800,000 - ADV (L-Axis) - 12,000,000 '
14,000 Opon Interent (Roaxis) | 50000 Open nterest (R-Axis) > Total 124 stock options contracts
12,000 - l | 40.000
40, 600,000 { NN
10,000 - - 8,000,000 * Market Makers (MMs)
l - 30,000
8,000 400,000 - » 3 types of market makers (PMM/ CQMM/
6,000 1 - 20,000 - 4,000,000 ORI
4,000 - 200,000 A » CQMM to provide 50 series continuous
- 10,000 .
2,000 - quotations
0 - -0 0 0
[S] N e == >c=s o > UC E‘—>\C5@QS
8582285335882 23588228353338823
2021 2022 202l1 2022

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 30 November 2022
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Hang Seng TECH Index Futures and Options Performance

Hang Seng TECH Index Open Interest (as of 30 November 2022)

Index Description

Tracks the largest technology companies

listed in Hong Kong

Hang Seng TECH Index Futures & Options & Futures Options
HK$50 per index point

HK$190K (As at 30 November 2022)
Options: 5

Contract Multiplier
Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*

Stam p Duty
Trading Fee
SFC Levy

N/A
HK$5.00 / contract
HK$0.54 / contract

Providing investors with a tool to manage their risk exposure
to Hong Kong-listed technology companies

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 30 November 2022

Open Interest
(No. of Contracts)

160,000 -

140,000 -

120,000 -

100,000 -

80,000 -

60,000 -

40,000 - . — _
85 3 22853 % &8 ¢
zozjj 2022 |

Average Daily Volume (as of November 2022)
ADV

(No. of Contracts)

120,000 -
100,000
80,000
60,000
40,000
20,000
0

2021 2022

Volume and Open Interest continue to growth
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MSCI China A 50 Connect Index Futures Performance

MSCI China A 50 Connect Index Average Daily Volume (as of November 2022)

. Balanced representation from 11 sectors
Index Description )
of top 50 China A shares ADV
(No. of Contracts)
Index Level 2,133.47 (As at 30 November 2022) 30,000 -
Index Volatility (30-Day Historical) | 22.1
Index Avg. Day High-Low Range 29.79 (November 2022) 20,000 +
CSI300 Correlation (2022 0.979
fon (2022) 10,000 -
FTSE A50 Correlation (2022) 0.978
0 -
Ol c O = =5 > c 75 O a B >
) |8 © 8 2 © 3 2 3 o KL ©
MSCI China A 50 Connect Index Futures o/l oL =2 < = 5 72 g 0o O =z
Contract Multiplier US$25 202]J 2022 |

Notional Value (1 Contract)

US$0.05Mn (As at 30 November 2022)

Open Interest (as of 30 November 2022)

Open Interest
(No. of Contracts)

Average Quote Size US$0.27Mn (5 Contracts)

35,000 +
Transaction Cost*
30,000 -
Stamp Duty N/A
. 25,000 -
Trading Fee US$0.5 / contract
SFC Levy US$0.07 / contract 20,000 1
Margin as of 21 Nov 2022 US$3,360 15,000 ole 2 = = = = = o a = -
© o > |5}
8S 2 s < £ 3> 2 § o 2
ZOZJJ 2022 |

Sector-balanced exposure to China’s A-share market Risk management tool for diversified China portfolios
Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference onlv

As at 30 November 2022
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MSCI Asia and Emerging Market Index Futures Performance

representation 38 DM and EM countries and
Index Description : o Open Interest
regional indices (No. of Contracts)
90,000 -
MSCI Asia and Emerging Market Index Futures 80.000 -
Contract Multiplier Average US$40 ’
Notional Value (1 Contract) Average US$44K (As at 30 November 2022) 70,000 -
No. of Liquidity Providers 12
60,000 -
Transaction Cost* 50,000
(&) c o = = > c = (@] o H >
) © Q > O &)
Stamp Duty N/A 2 g e 2 2 cErs = <3l2 8 o 3
Trading Fee US$0.6-US$1.0 / contract ]J |
SFC Levy US$0.07 / contract P02 2022
Average Daily Volume (As of November 2022)
ADV
(No. of Contracts)
40,000 -
30,000
20,000
10,000
0

202]J 2022
HKEX with the broadest suite of MSCI derivatives products

. . . Volume and Open Interest continue to growth
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 30 November 2022
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MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

MSCI AxJ

representation 2 DM countries (excl. Japan)

Index Description . )
and 9 EM countries in Asia

Index Level 411.07 (As at 30 November 2022)
Index Volatility (30-Day Historical) | 19.1
Index Avg. Day High-Low Range 6.63 (November 2022)

HSI Correlation (2022) 0.934

HSCEI Correlation (2022) 0.92

MSCI AxJ Futures

Contract Multiplier US$100

Notional Value (1 Contract) US$41K (As at 30 November 2022)
Avg. Quote Size US$0.21Mn (5 Contracts)

Avg. Bid-Ask Trading Spread 1.0 index points (November 2022)
Liquidity Providers Flow and 11 banks

Stam p Duty N/A

Trading Fee US$0.5 / contract

SFC Levy US$0.07 / contract

Margin as of 21 Nov 2022 US$3,320

Futures contracts have relatively lower transaction costs

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 30 November 2022

Open Interest (30 November 2022)

Open Interest
(No. of Contracts)

11
11

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

200 -
000 -
800 -
600 -
400 -
200 -

0

Dec
Jan
Feb
Apr
May
un
Jul
Aug
Sep
Oct
Nov

Mar

2021J 2022 |

MSCI AxJ -~ MSCI China MSCI HK
120 - MSCISG o MSClInda MSCI Indonesia
----------------- MSCI Korea e MSCI Malaysia MSCI Pakistan

110 - " MSCI Philippines - MSCI Taiwan MSCI Thailand
100

90

80

70 T : T 1

Sep-2022 Oct-2022 Nov-2022

MSCI AxJ is a well-established benchmark representing Asia

regional (excluding Japan) equity market performance

13



Hang Seng Mainland Banks Index Futures Performance

Hang Seng Mainland Banks Index (HSMBI) 5-Min Avg. Bid-Ask Spreads (30 November 2022)

L 10 largest and most representative
Index Description HSMBI Futures

HKEX-listed mainland banks stocks
CEB Bank 6818.HK
Minsheng Bank 1988.HK
Index Volatility (30-Day Historical) | 20.2 ABC 1288.HK
Bank of China 3988.HK
PSBC 1658.HK

0.69%
Index Level 2,413.74 (As at 30 November 2022)

Index Avg. Day High-Low Range 32.40 (November 2022)

HSCE Correlation (2022) 0.712 Bankcomm 3328.HK
CITIC Bank 998.HK
ICBC 1398.HK
Hang Seng Mainland Banks Index Futures CM Bank 3968.HK
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.12Mn (As at 30 November 2022)
Avg. Quote Size HK$0.60Mn (5 Contracts) Index & Constituents 3-Month Performance (Rebased to 100)
Avg. Bid-Ask Trading Spread N/A 110 - HSMBI CCB (939.HK)
ICBC (1398.HK) BOC (3988.HK)
Liquidity Providers NA ——ABC (1288.HK)
100 +
Transaction Cost*
Stam p Duty N/A
90 -
Trading Fee HK$2 / contract
SFC Levy HK$0.54 / contract
a 80 T T 1
Margin as of 21 Nov 2022 HK$5,850 Sep-2022 Oct-2022 Nov-2022
Futures contracts have relatively lower transaction costs HSMBI Futures can be used for hedging

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 November 2022



CES120 Index Futures Performance

CES120 Index 5-Min Avg. Bid-Ask Spreads (30 November 2022)

80 A-Shares and 40 HK-listed Mainland
China H-shares, P-chips, and red chips

Index Description

CES120 Futures | N/A
Index Level 5,482.59 (As at 30 November 2022)

Index Volatility (30-Day Historical) | 25.3

Index Avg. Day High-Low Range 109.35 (November 2022)

onnasc csooere usesi) [T

CSI300 Correlation (2022) 0.911

xistares aso 7 oz [ -
FTSE A50 Correlation (2022) 0.928

0,

p— CS0P FISE A ETF (26224) _ 016
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.27Mn (As at 30 November 2022)
Average Quote Size HK$1.37Mn (5 Contracts) CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)

Average Bid-Ask Trading Spread| N/A

120 e=CES120 Index Tencent CcCB
Liquidity Providers N/A 110 ——Ping An ——— China Mobile
100 -
Transaction Cost*
90 -
Stamp Duty N/A
_ 80
Trading Fee HK$5 / contract
70 A
SFC Levy HK$0.54 / contract
1 60 T T 1
Margin as of 21 Nov 2022 HK$15,120 Sep-2022 0ct-2022 NOV-2022
Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 November 2022



Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information ~ HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m>.HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv O#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X



MSCI Asia and Emerging Market Index Futures Access Codes

MSCI China |MSCI China |MSCI China i i MSCI EM MSCI EM MSCI EM ex
: NTR (USD) Free NTR i Asia NTR EMEA NTR |China NTR
Information (USD) Index |(USD) Index [|(USD) Index [(USD) Index [(USD) Index |(USD) Index
Vendor Futures Futures Futures Futures Futures Futures
Bloomberg HKCA Index MCYA Index CSIA Index HMSA Index CJEA Index HJEAIndex HQOA Index HQRA Index HRSA Index HQTA Index HQDA Index
Refinitiv O#HMAN:  O#HMCA: O#HCHI:  O#HMCU: O#HCHN: 0#HMCN: 0#HMAC: O#HMAK:  O#HEAN: O#HMEE:  O#HMXC:
WIND MANF.HK  MCAF.HK MCNF.HK EANF.HK

MSCI EM ex i MSCI Hong MSCI
. Korea NTR [ Kong NTR [ MSCI India Indonesia
Information [(UsD) Index (USD) Index NTR (USD) Index (USD) (JPY) Index
Vendor Futures Futures Index Futures |Futures Futures
Bloomberg HQIA Index HQYA Index HMPA Index HMOA Index HLCA Index HRTA Index HJDA Index HMLA Index HKBA Index HQAA Index
Refinitiv O#HMXK: O#HMEL: O#HMEM: O#HEMN: O#HMHN: 0#HMDA: O#HMIN: O#HMID: 0#HMDN: O#HMJIP:
WIND MINF.HK MDNF.HK

MSCI New MSCI Pacific MSCI MSCI
: MSCl Japan  |MSCl Japan |MSCI Malaysia [MSCI Malaysia |Zealand NTR [ex Japan NTR [MSCI Pacific |Philippines ilippi Singapore
Information [NTR (JPY) NTR (USD) (USD) Index  [NTR (USD) (USD) Index  [(USD) Index |NTR (USD) (USD) Index Free (SGD)
Vendor Index Futures |Index Futures |Futures Index Futures |Futures Futures Index Futures |Futures Index Futures |Index Futures
Bloomberg HQBA Index  HJCA Index HMYA Index  HKEA Index HOPA Index HRPA Index HRBA Index  HNSA Index HLEA Index HKOA Index
Refinitiv 0#HMIJ: 0#HMJIU: O#HMMY: O#HMMN: O#HMNZ: O#HMPJ: 0#HMPC: 0#HMPH: 0#HMPN: O#HMSG:
WIND MJUF.HK MMNF.HK

MSCI MSCI Taiwan
: Singapore MSCI Taiwan [MSCI Taiwan [25/50 NTR MSCI Taiwan [MSCI Thailand [MSCI Thailand [MSCI Vietnam [MSCI Vietnam
Information [USD) Index |NTR (USD) (USD) Index  [25/50 (USD)  |(USD) Index  [NTR (USD) (USD) Index  [NTR (USD) (USD) Index  [NTR (USD)
Vendor Futures Index Futures |Futures Index Futures |Futures Index Futures |Futures Index Futures |Futures Index Futures
Bloomberg HOBA Index HKPA Index HJAA Index HRCA Index HRDA Index HJIBA Index HMTA Index HKDA Index HNTA Index HKSA Index
Refinitiv O#HMGN: O#HMSN: O#HMTW: O#HTWP: O#HTWN: O#HMWN: O#HMTH: O#HMTN: O#HMVT: O0#HMVN:
WIND MTWFE.HK MWNF.HK MTNF.HK

Data Source: HKEX
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Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X
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Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor Mainland Banks
Index

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Information Vendor Mainland
Banks Index

East Money HSMBI

Hexin Flush Financial

Pobo Financial
Qianlong 999905

Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
0#HMBI:

Mainland Banks
Index Futures

MBI

MBIC

MBI+Month+Year
209

MBIF+yymm+HK
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. i CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X



